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Introduction 
SystmOne Results Auto-filing introduces changes to how incoming pathology and radiology results are processed. 
Pathology and radiology results are automatically saved (filed) into patient records at the moment the 
organisation receives them from the lab. Users must still perform a review of each incoming result, and can 
continue to actions these from the Pathology & Radiology Inbox, but saving (filing) the result to the patient 
record automatically allows organisations to introduce enhanced decision and workflow support when reviewing 
pathology and radiology results. 

TPP have introduced a range of new options to Clinical Reporting and Protocols that allow organisations to take 
advantage of the fact that pathology/radiology results are now saved to patient records automatically. This 
guide details these new options, and provides examples of use cases that demonstrate a variety of ways in which 
organisations can use the new capabilities.  
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Key Changes 
Auto-filing matched, assigned results 

Each new result is saved to the patient record when it is received if it matches to a patient and has an assigned 
recipient. Results that cannot be automatically matched to a patient or do not have an assigned recipient will be 
saved to the patient record when they are manually matched to a patient and assigned a recipient. 

Terminology changes 

The process of checking a result and recording details such as a result indicator and a follow-up action is 
unchanged, except this is now referred to as ‘reviewing’ instead of ‘filing’ to reflect that this process no longer 
saves the result to the patient record. For example the ‘File Report’ button is now ‘Mark Report as Reviewed’ 
and the ‘Bulk File’ button is now ‘Action Normal Reports’. 

Reviewing results from within the record 

Auto-filing means that results are visible to users in the patient record as soon as they are received, so users 
now have the option of reviewing results from the Pathology & Radiology node of the patient record as well as 
from the Pathology/Radiology Inbox. You can do this by right clicking on a result on this node and choosing 
‘Review’. 

Visibility to patients 

Although the results are saved to the record automatically and can be seen by users immediately, patients with 
online access do not gain visibility of them until a user has reviewed them. Users can still choose to untick the 
‘Visible in the online record’ option when performing a review if they do not deem it appropriate for the patient 
to see the result.  

SMS messaging 

SMS messages which previously triggered when a user filed a report will now trigger when a user reviews a 
report. These can be configured as before by going to Organisation Preferences > Pathology > SMS. 

Pathology & Radiology node 

Auto-filed pathology reports will show each battery contained within the report as a single row on the Pathology 
& Radiology node in the record. Each battery will show review details such as when the report was reviewed and 
by whom. 

Improvements to Protocols and Clinical Reporting 

Please see the Enhanced Functionality section for details on changes to these functionalities and how they relate 
to Results Auto-filing.  

Marking in Error 

Marking in error an auto-filed report from the Pathology/Radiology Inbox will mark in error the report in the 
patient record and unmatch the report from the patient. You can then find the report on the unmatched 
patients tab and match it to a patient, at which point it will be added to their record. 

If you mark in error an auto-filed report from the Pathology & Radiology node within the patient record, you will 
be given an option to decide whether or not to return the report to the Pathology/Radiology Inbox.  
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Decision Support Use Cases 
The following is a list of examples of decision support that can be implemented using the enhanced clinical 
reporting and protocols functionality with the content of results that have been auto-filed. At the point of 
reviewing a result, or when retrieving a record, the user is shown guidance on the interpretation of the result 
for that patient. 

 

HbA1c 

A protocol can trigger if the patient meets the following criteria: 

 The patient is not already diagnosed with diabetes 

 The patient has a previous HbA1c result >48mmol/mol within the last 12 months 

 The patient has an unreviewed result which contains a HbA1c result >48mmol/mol 

Where these criteria are met, the protocol can advise the user to consider recording a diagnosis of diabetes.  

 

TSH 

A protocol can trigger if the patient meets the following criteria: 

 The patient has a diagnosis of thyroid cancer or pituitary gland disease, or is currently pregnant  

 The patient has an unreviewed result which contains a TSH result which is between 0.5 and 5 and is 

therefore indicated as normal  

Where these criteria are met, the protocol can highlight reasons that the user may want to consider a change in 
treatment despite the result being indicated as normal.  

 

AST, ALT, platelet count 

A protocol can trigger if the patient meets the following criteria: 

 The patient has unreviewed results containing ALT, AST, platelet count 

 The patient does not have a recent FIB-4 score 

When these criteria are met, the protocol can calculate an updated FIB-4 score and provide tailored 
guidance based on that score. For example, if it is high the user can be advised to consider requesting an 
ELF or referring to hepatology.  

 

Serum creatinine 

A protocol can trigger if the patient meets the following criteria: 

 The patient has an unreviewed result containing serum creatinine 

When these criteria are met, the protocol can highlight CKD classification. 

 

ACR 

A protocol can trigger if the patient meets the following criteria: 

 The patient has an unreviewed result containing an ACR >3 mg/mmol to combine with the eGFR to 

calculate CKD classification. 

When these criteria are met, the protocol can suggest that the clinician consider clinical review.  
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PSA 

A protocol can trigger if the patient meets the following criteria: 

 The patient has an unreviewed result containing a PSA 

 The patient has an active prescription for finasteride or duasteride 

When these criteria are met, the protocol can remind the clinician that interpretation of the PSA should be done 
in the context of the active prescription impacting the result. 

 

Hypercholesterolaemia  

A protocol can trigger if the patient meets the following criteria: 

 The patient is not already diagnosed with hypercholesterolaemia 

 The patient is 16yrs or older and has an unreviewed result of total cholesterol >7.5mmol/L or LDL-

C >4.9mmol/L, OR 

 The patient is under 16yrs and has an unreviewed result of total cholesterol >6.7mmol/L or LDL-

C >4.0mmol/L 

Where these criteria are met, the protocol can advise the user to consider recording a diagnosis of 
hypercholesterolaemia or consider other pathology.  

 

 Immunosuppressant therapy 

A protocol can trigger if the patient meets the following criteria: 

 The patient has an unreviewed result containing a Neutrophil count 

 The patient has an active prescription for a medication in the action group Malignancy and 

immunosuppression 

When these criteria are met, the protocol can remind the clinician that interpretation of the Neutrophil should 
be done in the context of the active prescription impacting the result. 

 

Immunosuppressant therapy with Tocilizumab 

A protocol can trigger when the patient meets the following criteria: 

 The patient has an active hospital supplied prescription containing Tocilizumab 

 The patient has an unreviewed result containing a Neutrophil< 2 x109/litre but > 0.5 x109/litre  

When these criteria are met, the protocol can remind the clinician that interpretation of the Neutrophils should 
be done in the context of the active prescription impacting the result. 

 

Known Gilbert’s Syndrome 

A protocol can trigger when the patient meets the following criteria: 

 The patient has a diagnosis of Gilbert’s Syndrome 

 The patient has an unreviewed result containing a Bilirubin > 21µmol/L and < 85 µmol/L 

Where these criteria are met, the protocol can highlight that the user may not need to consider treatment 
despite the result being indicated as abnormal. 

 

Possible Gilbert’s Syndrome 

A protocol can trigger when the patient meets the following criteria: 
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 The patient is not already diagnosed with Gilbert’s Syndrome 

 The patient does not have a previous Bilirubin result > 21µmol/L  

 The patient has an unreviewed result containing a Bilirubin > 21µmol/L and < 85 µmol/L 

Where these criteria are met, the protocol can prompt the clinician to request LFT, Direct (conj) bilirubin, 
reticulocyte & FBC within 4 weeks 

A protocol can trigger when the patient meets the following criteria: 

 The patient is not already diagnosed with Gilbert’s Syndrome 

 The patient has a previous Bilirubin result > 21µmol/L within the last 3 months 

 The patient has an unreviewed result containing a Bilirubin > 21µmol/L and < 85 µmol/L 

Where these criteria are met, the protocol can advise the user to review results and consider recording a 
diagnosis of Gilbert’s Syndrome or referring to Hepatology if reticulocyte > 4 OR conjugated > unconjugated OR 
other LFTs abnormal 

 

Prescribing metformin 

A protocol can trigger when the patient meets the following criteria: 

 The patient has a current medication issue containing metformin 

 The patient has an unreviewed result containing an eGFR < 30 mL/min/1.73m2 

Where these criteria are met, the protocol can suggest a review of their metformin prescription. 

 

Vitamin D 

A protocol can trigger when the patient meets the following criteria: 

 The patient has an unreviewed result containing a Serum 25-Hydroxy vitamin D3 level > 40nmol/L and < 

60nmol/L 

Where these criteria are met, the protocol can prompt the clinician to review the result as “normal, no action 
required”. The result may be outside the laboratory reference range but within the bounds of tolerability as 
determined by an organisation 

 

Renal Function – ‘Low and Stable’ 

A protocol can trigger when the patient meets the following criteria: 

 The patient is 16 years or older and has an unreviewed result containing an eGFR <60 mL/min/1.73m2. 

 The patient has a recent eGFR result > X and < Y days before this result. 

 The current result is similar to the previous (less than Z ml/min/1.73m2 lower the previous OR any value 

greater than the previous) 

Where these criteria are met, the protocol can prompt the clinician to consider that the renal function is stable, 
as the eGFR result that is low but acceptable for that patient at this point in time. 

 

Renal Function – ‘Low and Falling’ 

A protocol can trigger when the patient meets the following criteria: 

 The patient has an unreviewed result containing an eGFR <60 mL/min/1.73m2. 

 The patient has a recent eGFR result > X and < Y days before this result. 

 The current result is different to the previous (more than Z ml/min/1.73m2 lower the previous)  
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Where these criteria are met, the protocol can prompt the clinician to consider that the patient may have acute 
renal failure, as the eGFR result is low with a significant recent drop. 

 

Workflow Support Use Cases 
Protocols used in the context of the results workflow can also support users with more efficient means of 
performing additional actions for the results they are reviewing. For example: 

 

 Save a numeric to the record that has been calculated using a new result, such as FIB-4 

 Use protocol variable functionality to calculate and display the percentage difference between the 

current and most recent eGFR 

 Launch a visualisation with a graph component to provide a clear picture of PSA velocity to help 

differentiate prostate cancer from benign enlargement 

 Send a task to a local team alerting them of a new diabetes diagnosis to trigger follow-up activity 

 Give an option to launch a quick action, such as ‘New Acute > Specific formulary entry’ to prescribe an 

ACE inhibitor for a low PCR, or ‘New Electronic Referral > Preconfigured Electronic Referral’ to send a 

preconfigured referral to hepatology for a patient with a high FIB-4 score 

 Use protocol variable functionality to generate a message to be sent to the patient’s preferred 

communication method using the comms annexe asking them to contact the organisation to discuss their 

TSH result 

 Display a hyperlink to launch additional external guidance on diagnosing hypercholesterolaemia 

 Use protocol variable functionality to show the % change in LDL after starting statin (drug start date 

within x months) 

 Use protocol variable functionality to show the change in HbA1c (or not)  after starting metformin  
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Enhanced Functionality 
It is now possible to make use of the content of incoming results in a number of innovative ways. New 
functionality detailed in the following sections provides opportunities for organisations to implement protocols 
that can interpret a result in the context of the patient record in order to automate workflow steps and deliver 
tailored decision support to both users and patients. This functionality underpins the use cases described earlier 
in this guide. 

The following sections are aimed at users who are already familiar with Protocols and Clinical Reporting 
functionality. Those without existing knowledge of the core concepts may wish to work through the Protocol 
Example section in this guide first, and you can find further guidance on these functionalities in the Help section 
of SystmOne.  

 

Clinical Reporting 

You can now report on numeric readings in the context of the pathology/radiology report within which they 
were received. Previously it was possible to report on numeric readings using the numerics node in clinical 
reporting, but the options on this node did not allow you to report on any data relating to the pathology report 
that delivered the numeric reading, such as when the report was received, or if it had been reviewed. New 
options have been added to the Pathology/Radiology Reports node to facilitate reporting specifically on 
numerics that have been received in pathology reports. 

You can now report on the ‘Reviewed status’ of the pathology report, and ‘Reviewed status date’. You can also 
use the ‘Content of report contains numeric’ option and the ‘Specific numeric’ option to set the clinical report 
to only return patients who have a pathology report that contains a numeric reading of your choosing, where the 
value of the reading is greater than, or less than, a specified value, or between, or not between, two specified 
values. 

These options are useful for building clinical reports that help the protocol work out when decision support 
should be presented to the user. For example, a clinical report can now determine that a patient has a HbA1c 
result >48mmol/mol that is in a pathology report that has not been reviewed. When used in a protocol this 
prevents the protocol from triggering decision support for a patient who has a HbA1c >48mmol/mol and an 
unrelated pathology report that has not been reviewed. 

To use a clinical report to set when the protocol should trigger go to the Filters tab of your protocol and set the 
clinical report in the ‘Only applies to patients in report’. You can also use clinical reports to determine the route 
a protocol takes after it has been triggered using the ‘In Report’ branch which you can find on the Available 
Steps panel of a protocol’s Design tab. 

Note that for auto-filed reports the date that the report was filed equates to when the report was received and 
automatically saved to the record, and does not represent when the report was actioned by the organisation. 
Ensure that you report on the date that the report was reviewed, rather than filed, if you want to identify when 
it was actioned. 
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Figure 1: New options for creating a report to find patients with a HbA1c >48mmol/mol in a pathology report 
that has not been reviewed 

 

Figure 2: Applying a clinical report as a protocol filter, so that it only triggers for patients who have a HbA1c 
>48mmol/mol in a pathology report that has not been reviewed 



These instructions are correct at the date of writing. For further assistance, consult the SystmOne Online Help. 

 

 

 9 ©TPP 2023 – Commercial in confidence  Please note: All patient data shown in this document is fictitious. 

Protocol Triggers 

The ‘patient record retrieve’ trigger is a useful option for specifying when a decision support protocol should 
activate. When used in combination with a suitable clinical report filter on the protocol, you can display 
guidance to users when they retrieve a record which contains a specific numeric reading in a pathology report 
that has not yet been reviewed. This will trigger when a user views a report from the Pathology/Radiology Inbox, 
as this retrieves the patient record, and it will also trigger when a user retrieves a patient record from 
elsewhere in the system (as long as the criteria set on the Trigger and Filters tabs of the protocol are met). 

Alternatively, you can make use of a new protocol trigger: ‘Pathology/Radiology report review started’. This 
allows you to focus a protocol at users who are actively reviewing pathology reports, and prevents the protocol 
from triggering for users who may be retrieving patient records for unrelated reasons. The protocol will activate 
when the user starts a review of a report, either from the Pathology/Radiology Inbox using the ‘Mark Report as 
Reviewed’ option, or from the Pathology & Radiology node of the patient record using the right click option 
‘Review’.  

This trigger also contains the ability to restrict the protocol to activate only if the user is reviewing a report that 
contains at least one of the specified codes. You can also specify whether the presence of children of the 
specified codes should active the protocol using the ‘Include child codes’ tick box. This provides a simplified 
alternative to using a clinical report on the Filters tab of the protocol. 

There is also a new option to further restrict when the protocol triggers based on the user’s membership of a 
Team. You can set this selecting the ‘Restrict triggering based on staff member’ tick box on the Trigger tab. This 
is useful for limiting the protocol to only trigger for users to whom the decision support is relevant. 

 

 

Figure 3: New options set to trigger a protocol when a member of the Pathology/Radiology Team starts a review on 
a TSH report 
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Protocol Variables 

Protocol variables allow you to specify values that can be used within the protocol to drive a range of functions. 
It has both simple and complex applications and incorporates four core components: 

Declare Variable – use this to create a new variable 

Change Variable – use this to change the content of the variable 

Test Variable – use this to test the content of the variable against parameters you specify 

Save Variable – use this to save the value of a numeric variable to the patient record using a numeric code you 
specify (this component has not been changed) 

These options can be found in the Variables section of the Available Steps panel of a protocol’s Design tab. TPP 
has improved this functionality in a number of ways to support the introduction of protocols into the 
pathology/radiology review process. 

 

Declaring Variables 

As well as declaring a variable to contain a numeric, you can now create variables that contain either a date and 
time or a piece of text.  

Date and time variables can be associated with numerics, and can be output in Information and Question 
components, as well as in Reminders that the protocol adds to the patient record. This allows you to display the 
date and time of a reading to users in decision support. For example, you can show an Information dialog to a 
user as the result of a protocol that includes the date and time of the last HbA1c that the patient had, before 
the current HbA1c that they are reviewing. 

Free text variables can also set by the protocol if it goes down the branch that contains them. They can then 
also be output in Information and Question components, and in Reminders. This allows the protocol to 
dynamically build multiple lines of text. You can then display one or more text variables to the user in one of 
the output options. This could be guidance on next steps, contextual information from the patient record to help 
them interpret a result, or a message to send to the patient using the Comms Annexe. For example, the protocol 
may set and then display a text variable stating that the patient has good control of their diabetes if it has 
checked relevant data and found this to be the case. 

This means you can now display all three types of variables within an output, giving the user information using 
numerics, text, and dates and times. To do this, add the relevant component – Information, Question, or Add 
Reminder, and type @ followed by the name of the variable e.g. ‘@DiabetesGoodControlAdvice’, 
‘@HbA1cLatestReading’, ‘@HbA1cDateAndTime’, etc. 

 

 

Figure 4: New Declare Variable options 
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Changing Variables 

When using a Change Variable component to set a variable to use the value of a numeric reading from the 
patient record you now have additional options. These allow you to specify parameters such as whether the 
value should be set to the most recent, highest, lowest, or mean of all matching readings within a specified time 
range. For example, you can use this to set a variable to the value of the patient’s highest HbA1c within the last 
year. 

You can choose to ignore one or more of the most recent readings. This is useful when creating multiple 
variables to contain an array of multiple results for the same test. These can then be tested against each other 
using the Test Variable component to identify and highlight trends. 

Some results received from the lab may contain comparison operators to indicate that the result was greater 
than or less than a given number. You can choose to exclude these readings from consideration when the 
protocol sets the value of the variable. If you include them, the protocol will strip the comparison operator and 
use the remaining number as the value of the variable. 

You can specify whether the reading should only be set as the value of the variable if it is greater than or less 
than a number you specify, or if it is between, or not between, a range you specify.  

Lastly, you can optionally set the name of a date and time variable to be created. This will hold the date and 
time of the consultation date of the reading used to set the value of the variable.  

 

 

Figure 5: New Change Variable options 
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Testing Variables 

You can now use this component to test the two new types of variable – free text, and date and time.  

When using this component with text variables you can set the protocol to test whether the variable contains 
specified text. You can also test whether it exactly matches specified text. You can then send the protocol down 
one or another branch depending on the result of the test. 

When using this component with date and time variables you can set the protocol to test whether the date and 
time of the reading is on, after, or before a specified date, or between two dates. 

 

 

Figure 6: New Test Variable options for Text 

  

Figure 7: New Test Variable options for Date and Time 
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Example Protocol Build 
This section guides you through the process of building a protocol that advises the user to consider recording a 
diagnosis of diabetes when a new pathology result indicates that this may be appropriate1. 

1: Go to Reporting > Clinical Reporting and create a new report. This report will identify patients that have not 
been diagnosed with diabetes but have at least two Hba1c results >48mmol/mol within the last year, where one 
of the results has not yet been reviewed. You can do this by creating two separate reports and joining them 
together. 

Create a report to find patients who have a HbA1c >48mmol/mol in a pathology report that requires review. This 
can be done using the options on the Pathology/Radiology Reports node. Set the Reviewed status to Required. 
Specify the numeric reading used by your lab to send HbA1c results e.g. Haemoglobin A1c level - IFCC 
standardised (XaPbt), and set the report to look for readings >48mmol/mol. 

 

 

Figure 8: HbA1c >48mmol/mol requires review  

 

 

 

 

 

                                                      
1 https://cks.nice.org.uk/topics/diabetes-type-2/diagnosis/diagnosis-in-
adults/#:~:text=HbA1c%20of%2048%20mmol%2Fmol,symptoms%20or%20signs%20of%20diabetes.  

https://cks.nice.org.uk/topics/diabetes-type-2/diagnosis/diagnosis-in-adults/#:~:text=HbA1c%20of%2048%20mmol%2Fmol,symptoms%20or%20signs%20of%20diabetes
https://cks.nice.org.uk/topics/diabetes-type-2/diagnosis/diagnosis-in-adults/#:~:text=HbA1c%20of%2048%20mmol%2Fmol,symptoms%20or%20signs%20of%20diabetes
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2. Now create a second report. This report should find patients who have more than one HbA1c >48mmol/mol 
within the last year. To do this you need to set options on three different nodes of Clinical Reporting. The Event 
Dates node should be set to only look for patients with events within the last year. 

 

Figure 9: Events within the last year 

 

The Event Counts node should be set to find patients who have more than one matching event. 

 

Figure 10: More than one matching event 
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The Numerics node is where you will specify the event: a HbA1c reading >48mmol/mol.  

 

Figure 11: HbA1c >48mmol/mol 

 

3. Now you need to join your reports together. On the Clinical Reporting screen find and select both reports and 
then click Join. The Join type should be ‘Report on patients found in both the selected reports’. 

 

Figure 12: Joining the reports 



These instructions are correct at the date of writing. For further assistance, consult the SystmOne Online Help. 

 

 

 16 ©TPP 2023 – Commercial in confidence  Please note: All patient data shown in this document is fictitious. 

4. You will also need another report that will be used as a branch in the protocol to stop it advising users to 
diagnose diabetes for patients who already have a diagnosis. Create a new report and use the Coded Entries 
node to find patients who have a diagnosis of diabetes. Using the diabetes parent code including children will 
find patients who have been diagnosed using different diabetes codes. You now have all the clinical reports you 
need to create your protocol. 

 

 

Figure 13: Patients with diabetes 

 

5. To start building the protocol go to Setup > Workflow Support > Protocols and click New Protocol. On the 
Details tab give your protocol a name, select or create a category, and choose an icon. 

 

Figure 14: Details tab 
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6. Go to the Trigger tab. Untick the option ‘Allow this protocol to be launched manually’, and tick the option 
‘Allow this protocol to be launched automatically’. In the ‘Trigger this protocol’ field choose ‘Patient record 
retrieve’. On this tab you may also choose to restrict the protocol to only launch for certain staff members 
based on users, roles, and teams. 

 

Figure 15: Trigger tab 

 

7. Go to the Filters tab. In the ‘Only applies to patients in report’ field choose the clinical report that you 
created in step one. 

 

Figure 16: Filters tab 
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8. Go to the Design tab. On the Available Steps panel on the left, click Declare Variable and then click on the 
Protocol Flow panel on the right to add the component underneath the Start box. You will be asked to set a 
Variable name – call it ‘HbA1c’. When you are asked to set the Variable type leave it set to Numeric, and when 
you are asked to set the Initial Value leave it set to zero. Drag a connecting line from the Go section of the Start 
box to the Declare Variable component. 

 

Figure 17: Declare Variable 
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9. Now that you have declared a variable you need to add a step to set its content to the value of the patient’s 
most recent HbA1c. Click Change Variable and then click on the Protocol Flow pane below the Declare Variable 
step to add the component. In the first dropdown field on the Configure Change Variable dialog choose @HbA1c. 
In the second dropdown choose Reading. Click the ‘Set numeric readings’ button and choose the same numeric 
you used in your clinical reports earlier. You can now Ok the dialog as the default settings are to use the most 
recent reading within the patient’s record. In the case of patients with an unreviewed HbA1c this will be the 
most recent reading in the record (if auto-filing is enabled). Add a connecting line between this component and 
the previous one. 

 

Figure 18: Change Variable 
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10. You now need to add an In Report branch using the clinical report you created earlier to determine if the 
patient is already diagnosed with diabetes. Select the In Report branch and click on the Protocol Flow to add it, 
choosing the report you created in step 4 when prompted. Connect the components. 

 

 

Figure 19: Branching the protocol based on whether the patient is diagnosed diabetic 
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11. Add a Question branch. This will be used to display a question to the user if the protocol triggers and the 
patient is not already diagnosed diabetic. Add some text explaining why the protocol has triggered. You can also 
display the most recent HbA1c result by typing ‘@’ followed by the name of the variable: ‘@Hba1c’. This will be 
replaced by the value of the variable when the question is shown to the user. You may also wish to describe the 
logic used by the protocol to further explain what criteria must be met in order for the protocol to stop 
triggering when the patient record is retrieved. Using a Question branch allows you to add bespoke answers to 
drive the next steps of the protocol. For this example, delete the Yes and No answers and replace them with 
‘Add diabetes diagnosis’ and ‘Cancel’. Ok the dialog to add the Question branch and then link this to the ‘N’ 
section of the In Report branch so that it only appears if the patient is not in the report. In this example the ‘Y’ 
section of the does not continue to another step, which means the protocol will not display an output to the 
user. You could choose to continue the protocol with advice on further steps for the user to take if the patient is 
already diagnosed diabetic. 

 

 

Figure 20: Using a Question branch to show the output of the decision support 
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12. If the user chooses to add a diabetes diagnosis, you can simplify the process of adding this by including an 
Action in the protocol. Click on Action in the Outputs section and then click on the Protocol Flow under the 
Question branch. You will be asked to choose a Quick Action – search for and select ‘New Coded Entry’ and then 
click Ok to add it. Connect the ‘Add diabetes diagnosis’ section of the Question branch to your New Coded Entry 
action. This will launch the code browser to allow the user to search for and add an appropriate diabetes 
diagnosis code. The Add Code Output is a useful alternative where the user does not need to choose a code, as 
this allows the protocol to add a code to the patient record without user interaction. 

Alternatively, you could add an answer called ‘View HbA1c results’ that launches a Visualisation showing you 
current and historical results, and relevant medications, which also gives the user an opportunity to consider 
recording a diagnosis. 

If the user chooses Cancel in answer to the question, the protocol will end.  

 

Figure 21: Prompting the user to add a coded entry 
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13. All that remains now is to publish the protocol. Click Ok on the protocol window to close it, and then find 
your protocol in the Unpublished folder on the Protocols screen. Select the protocol and then click Publish. You 
can choose to publish the protocol locally or to any of your organisation groups. The protocol will now start 
displaying the decision support when the relevant criteria are met. 

 

 

Figure 22: Decision support displayed to the user 
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Future Changes 

Following the full roll out of Results Auto-filing TPP are now working to introduce a number of additional 
functionalities to improve the workflow for processing results and these will be moving to pilot in due course. These 
include: 

Auto-Reviewing Rules Engine  

This will allow organisations to specify rules that determine whether certain results can be ‘auto-reviewed’ within 
the context of the incoming result and the patient. An example rule for incoming HbA1cs could identify that the 
patient in question is not diabetic and the result is within a range of 21-40mmol/mol. The engine can then remove 

the result from the Pathology & Radiology Inbox and mark the review as not applicable. The engine will also 
support the automation of some common actions that are performed when reviewing results. This will reduce the 
number of results that clinicians need to manually review. 

Improvements to the Communications Annexe  

Changes will be made to support the use of the Communications Annexe within the results workflow. For example, 
it will be possible to design a protocol to automatically create and send a communication to the patient using 
information from the current result, free text determined within the protocol, and information from the patient record. 
This will allow for the automation of dynamic patient messaging within the results workflow, reducing the effort 
required to inform patients of their results and provide advice and guidance on next steps. For example, the 
protocol may determine based on the result and the patient that the message to be sent should include instructions 
for booking a follow up appointment, along with details of the numeric results and targeted lifestyle advice based on 
the specific range within which the result falls. 

Marking more results as normal on arrival  

Many results received from labs cannot be marked as normal due to the presence of a numeric without an 
associated reference range, or the presence of some element of free text provided by the lab that it is assumed 
should be read by a clinician. An intelligent rules engine for checking incoming results is planned to determine 
when specific examples of these factors should not prevent results from being marked as normal on arrival. This 
will for example ignore free text from the lab that is deemed to add no value to the clinician’s process of interpreting 
the result. Marking more results as normal will support the automation of the processing of a greater volume of 
results. 

 


